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Chapter 1: WebLM overview

Avaya provides a Web-based licence manager (WebLM) to manage licenses of one or more
Avaya software products for your organization. WebLM is a Web-based license manager that
facilitates easy tracking of licenses. To track and manage licenses in an organization, WebLM
requires a license file from the Avaya Product Licensing and Delivery System (PLDS) Web site
at https://plds.avaya.com.

WebLM supports two configurations models:

• WebLM standard model. In this model, a single WebLM server supports one or more
licensed products. The WebLM standard model supports the Standard License File (SLF)
and Enterprise License File (ELF) types.

• WebLM enterprise model. This model includes multiple WebLM servers. One WebLM
server acts as a master WebLM server and hosts the license file from PLDS. The
remaining WebLM servers act as the local WebLM servers and host the allocation license
files from the master WebLM server. You need an ELF to set up the WebLM enterprise
model. PLDS generates license files that are SLFs or ELFs.

You can purchase two products and choose the enterprise model of licensing for one product
and the standard model of licensing for the other product. PLDS generates a separate license
file for each product.

The license file is an SLF or ELF based on how the product is configured in PLDS. Ensure that
you verify the installation options that the product supports before you install the WebLM server.
To configure the standard licensing, you can use an ELF or SLF. To configure enterprise
licensing, you must have an ELF. After you install the license file on the WebLM server, a
product with an ELF can have multiple instances of the WebLM server. However, a product
with an SLF can have only one instance of the WebLM server.

The license file of a software product is in an XML format. The license file contains information
regarding the product, the major release, the licensed features of the product, and the licensed
capacities of each feature that you purchase. After you purchase a licensed Avaya software
product, you must activate the license file for the product in PLDS and install the license file
on the WebLM server.

If you experience any problems while using WebLM, see Troubleshooting WebLM (stand-
alone) on page 50.
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Chapter 2: WebLM configuration models

All Avaya software products with WebLM capabilities are known as licensed applications.
When you install licensed applications in an organization, the applications require a feature
license to provide normal operations. The WebLM server provides feature licenses to licensed
applications in response to feature license requests from the applications. Therefore, all
licensed applications installed in the organization must have network connectivity to at least
one WebLM server, which has feature licenses of the product.

To suit particular needs and infrastructure of an organization, an organization can configure
the WebLM in the following models:

• WebLM standard model

• WebLM enterprise model

 Note:
For information on selecting the appropriate configuration model for your organization, see
Recommendations to select a WebLM configuration model on page 59.

WebLM standard model
In the WebLM standard model, the WebLM server is used to support one or more licensed
application instances. In this model, an administrator can perform the following tasks through
the WebLM server:

• Install a license file on the WebLM server.

• Manage WebLM users.

• Track feature licenses acquired by licensed applications.

• Generate a usage report for the feature licenses.

WebLM enterprise model
In a WebLM enterprise model, multiple instances of the WebLM Server exists. A license file
from RFA, enterprise license file (ELF), is installed on one of these WebLM Servers, making
the server the master WebLM Server of the enterprise. The remaining WebLM Servers can be
configured to receive feature license allocations from the master WebLM Server. The servers
that receive allocations from the master WebLM Server are referred to as local WebLM
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Servers. A WebLM Server can function as a master WebLM Server for one software product
and as a local WebLM Server for another software product.

To understand the concept of master WebLM Server and local WebLM Server, let us consider
a university that has two WebLM Servers. One WebLM Server is installed in California and the
other is installed in New York.

 Note:
All examples in this guide are based on a case study. For more information on the case
study, see Using the examples in the guide.

The WebLM Server in New York can function as the following servers:

• Master WebLM Server for the Encyclopedia Britannica 2005 Ultimate Reference Guide
product

• Local WebLM Server for the Britannica Deluxe Edition 2005 product

Similarly, the WebLM Server in California can function as the following servers:

• Master WebLM Server for the Britannica Deluxe Edition 2005 product

• Local WebLM Server for the Encyclopedia Britannica 2005 Ultimate Reference Guide
product

An organization with WebLM enterprise model contains one or more local WebLM Servers
connected to a master WebLM Server. Each local WebLM Server can support one or more
licensed applications.

Master WebLM server
A master WebLM server is a WebLM server that manages the local WebLM servers of a
software product. A master WebLM server provides feature licenses to the local WebLM
servers that are provisioned on the master WebLM server.

When a WebLM server is configured as the master WebLM server, an administrator can use
the server to perform the following tasks:

• Install a license file.

• Administer local WebLM servers.

• Allocate feature licenses to local WebLM servers.

• Track the allocated feature licenses.

• Periodically generate the usage report for the feature licenses allocated to the local
WebLM servers or for floating licenses available with the master WebLM server.

• Periodically allocate feature licenses to local WebLM servers.

• Manage floating feature licenses.
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• Manage WebLM users.

• Free allocated feature licenses from the local WebLM servers.

• Uninstall the license file.

Local WebLM server
A local WebLM server is a WebLM server to which the master WebLM server allocates feature
licenses of a software product. The licensed applications can then acquire feature licenses
from the local WebLM server. When a WebLM server is configured as a local WebLM server,
an administrator can use the server to perform the following tasks:

• Track feature licenses acquired by licensed applications.

• Generate a usage report for the feature licenses.

• Manage local WebLM server users.

Types of WebLM license files
To support the requirements of the WebLM configuration models, WebLM provides the
following types of license files:

• Standard license file (SLF)

• Enterprise license file (ELF)

• Allocation license file (ALF)

 Note:
For any type of the license files, the name of the license file must consist of ASCII
characters.

Standard license file
Standard license file (SLF) is used in the WebLM standard model. If an organization plans for
a WebLM standard model configuration, the organization must obtain an SLF from Product
Licensing and Delivery System (PLDS) available at https://plds.avaya.com. You can install the
SLF on the WebLM server of the WebLM standard model. For more information on the WebLM
standard model, see WebLM standard model on page 7.

Types of WebLM license files
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Enterprise license file
Enterprise license file (ELF) is used in the WebLM enterprise model. If an organization plans
for a WebLM enterprise model configuration, the organization must request for an ELF from
the PLDS team. You can only install the ELF on any one WebLM server. The WebLM server
on which you installed the ELF acts as the master WebLM server for the product in the WebLM
enterprise model. For more information on the WebLM enterprise model, see WebLM
enterprise model.

Allocation license file
Allocation license file (ALF) is used in the WebLM enterprise model. A master WebLM server
generates an ALF for a local WebLM server. This file contains information regarding the feature
licenses allocated to a local WebLM server. You can install the ALF on a local WebLM server
of the WebLM enterprise model. For more information on the local WebLM server, see Local
WebLM server on page 9.
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Chapter 3: Getting started with WebLM

Installing a license file
Use this functionality to install a license file on the WebLM server. If you are reinstalling a
license file on a WebLM server on which the license file that Remote Feature Activation (RFA)
generated is installed, you must remove the license file that RFA generated from the WebLM
server before you install the new license file. Use the Uninstall functionality to remove the
license file from the WebLM server.

Before you begin

• Obtain the license file from the Avaya Product Licensing and Delivery System (PLDS)
Web site at https://plds.avaya.com.

• Log on to WebLM Home.

About this task
If you experience problems while installing the license file, see Troubleshooting the license file
installation failure on page 50.

Procedure

1. In the left navigation pane, click Install license.

2. On the Install license page, enter the license file path. You can also click Browse
to select the license file.

3. Click Install to install the license file.
WebLM displays a message upon successful installation of the license file. The
installation of the license file can fail for various reasons, such as:

• WebLM finds an invalid digital signature on the license file. If you get such an
error, request PLDS to redeliver the license file.

• The current capacity use exceeds the capacity in the installed license.

Related topics:
Install license field descriptions on page 12
Scenario 01 on page 50
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Install license field descriptions
Use this page to install the license file of a product on the WebLM server.

Field/Button Description

Enter license path Specify the complete path where you saved
the license file.

Browse Opens the dialog box using which you can
select the license file.

Install Installs the product license file.

Related topics:
Installing a license file on page 11

Licensed products

Viewing the license capacity of the product features
Use this functionality to view the license capacity of the features of a product for which you
installed a standard license file.

Before you begin

• Log on to WebLM Home.
• Install the standard license file on the WebLM server for the licensed product.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click View license capacity.
The content pane displays the capacity of the licensed features of the product.

Related topics:
View license capacity field descriptions on page 15

Getting started with WebLM
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Viewing peak usage for a licensed product
Before you begin

• Log on to WebLM Home.
• Install the standard license file on the WebLM server for the licensed product.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click View peak usage.

Related topics:
View peak usage field descriptions on page 16

Viewing the license capacity of the licensed features of a product
Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click View by feature.

Related topics:
View by feature field descriptions on page 17

Viewing the connectivity status of the local WebLM servers
Before you begin
Log on to WebLM Home.

Licensed products
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Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click View by local WebLM.
The page displays the connectivity status of the local WebLM servers.

Related topics:
View by local WebLM field descriptions on page 18

Configuring enterprise licensing
Before you begin

• Log on to WebLM Home.
• Install the enterprise license file on the WebLM server for the product.

To verify the type of the license file for a product, in the left navigation pane, click Licensed
products and select the product name. The content pane displays the product name,
System Identification number (SID), and the license file type installed for the product at
the top of the page.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. In the left navigation pane, click Enterprise configuration.

3. On the Enterprise Configuration page, enter the appropriate information in the
fields.
For a detailed information of the fields, see Enterprise Usage field descriptions on
page 32.
To successfully set up and configure the master WebLM server, enter valid
information in the mandatory fields that are marked with a red asterisk.

4. In the Master WebLM Configuration section, enter the name, description, and IP
address of the master WebLM server.

5. In the Default Periodic Operation Settings section, enter the retry count and the
retry interval in minutes for the periodic operations.

6. In the SMTP Server settings section, enter the name of the SMTP server.

7. In the E-mail notification settings for periodic operation section, perform the
following:

Getting started with WebLM
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a. Set the E-mail notification to On.

b. In the E-mail address field, enter an e-mail address.

c. To add the e-mail address to the list of recipients for the WebLM server to send
e-mail notifications, click Add To List.

8. In the Default Periodic License Allocation Schedule section, select the day and
time for periodic license allocations.
The values you enter in this section remain as the default setting for periodic
allocation for all local WebLM servers in the enterprise.

9. In the Default Periodic Usage Query Schedule section, select the day and time
of the query for periodic usage.
The values you enter in this section remain as the default setting for periodic usage
for all local WebLM servers in the enterprise.

 Note:
For any periodic operations, you must perform the manual allocation at least
once.

10. Click Submit.
The system validates the information. The system displays the host ID in the MAC
ID field. The host ID is the host ID of the computer where you installed the WebLM
server.

Related topics:
Enterprise Configuration field descriptions on page 18

View license capacity field descriptions
Use this page to view the total number of feature licenses of a product that the organization
has purchased and the current allocation of these purchased licenses.

Field Description

Feature (Keyword) The display name of the licensed features of
the product and the keywords of each
feature. The keywords represent the
licensed feature in the license file.

Expiration Date The date on which the license for the feature
expires. The date on which the feature
license expires.

Licensed The number of feature licenses purchased
by the organization for each licensed feature.

Licensed products
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Field Description

The system gathers the number of feature
licenses information from the license file.

Acquired The number of feature licenses that are
currently in use by the licensed application.
For features of type Uncounted, the column
displays Not counted.

The Acquired licenses table displays information about the licenses acquired by the licensed
application. You can view this table only if the licensed product has acquired feature
licenses.

Field Description

Feature The feature keyword for each licensed
feature that is currently acquired by a
licensed application.

Acquired by The name of the licensed application that has
acquired the license.

Count The number of feature licenses that are
currently acquired by the licensed
application.

View peak usage field descriptions
Use this page to view the usage information of feature licenses of a licensed application for
different time intervals.

Field Description

Feature (License Keyword) The display name of the licensed features of
the product and the keywords of each
feature. The keywords represent the
licensed feature in the license file.

Currently allocated The number of feature licenses purchased
by the organization.

Usage: qty/% The number of feature licenses for each
licensed feature that a licensed application
currently uses. The column also displays the
percentage of usage.
For example, if 50 feature licenses are
available and five feature licenses are used
by applications, the column displays 5/10%.

Getting started with WebLM
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Field Description

Peak usage (last 7 days): qty/% The highest number of feature licenses for
each licensed feature that has been used in
the last seven days.
For example, if the peak usage for a feature
license in the past seven days was 25, and
the number of available licenses during
these seven days was 50, then the column
displays 25/50%.

Peak usage (last 30 days): qty/% The highest number of feature licenses for
each licensed feature that has been used in
the past 30 days.
For example, if the peak usage for a feature
license in the past 30 days was 50, and the
number of available licenses during these 30
days was 50, then the column displays
50/100%.

Time of query The date and time when the last usage query
for WebLM was executed.

Status The success or failure of the last usage query
executed for the WebLM server.

View by feature field descriptions
Use this page to view the license capacity for each feature license of a product.

Name Description

Feature (License Keyword) The display name and the keyword for the
licensed features of the product.

License Capacity The total number of feature licenses that the
organization purchases for each feature.

Currently available The number of floating licenses of each
feature that is currently available with the
master WebLM server.
The feature licenses that are not allocated to
any local WebLM server are known as
floating licenses.

 Note:
For uncounted features, this column
displays “Not counted”.

Licensed products
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Related topics:
Viewing the license capacity of the licensed features of a product on page 13

View by local WebLM field descriptions
Use this page to view the information related to local WebLM servers of a product.

Name Description

Local WebLM name Specifies the name of the local WebLM
server.

IP address Specifies the IP address of the local WebLM
server.

Last contacted Specifies the date and time when the local
WebLM server was last contacted.

Status Lists the success or failure of the last
connection request to each local WebLM
server.

Related topics:
Viewing the connectivity status of the local WebLM servers on page 13

Enterprise Configuration field descriptions
Use this page to specify the master WebLM server settings and the default settings for the
periodic operations of the server. The settings you specify in the Enterprise Configuration Web
page applies to the entire enterprise unless you override the setting while you add a local
WebLM.

The master WebLM server uses the settings of the periodic operations to query itself and
generate the usage report for licenses.

Master WebLM Configuration

Name Description

Name Specifies the name of the WebLM server.

Description Provides a brief description of the server.

IP address Specifies the IP address of the WebLM
server.

Getting started with WebLM
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Name Description

MAC ID Specifies the host ID of the computer where
you installed the WebLM server. You cannot
edit the MAC ID field.

Default periodic operation settings

Name Description

Retry count Specifies the number of times a master
WebLM server should try to connect to a
local WebLM server for a periodic operation
after a connection failure.
For example, set the count to 2. The master
WebLM server makes an initial unsuccessful
attempt to connect to a local WebLM server.
The master WebLM server makes two more
attempts to connect to the local WebLM
server.

Retry interval Specifies the duration, in minutes, within
which the retry count specified in the Retry
count field must be carried out.
For example, suppose the Retry count is 2
and the Retry interval is 10 minutes. If the
attempt to connect to the server fails, the
master WebLM server makes two attempts
in 10 minutes to connect to the local WebLM
server.

SMTP Server Settings

Name Description

Server name Specifies the name of the SMTP server.

E-mail notification settings for periodic operation

Name Description

E-mail notification Specifies the e-mail notification. The
notification options are:

• On: Sends an e-mail notification to the
administrator if the periodic operations
fail.

• Off: Does not send an e-mail notification to
the administrator if the periodic operations
fail.

Licensed products
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Name Description

E-mail address Specifies the e-mail address to which the
WebLM application sends the e-mail
notification if the periodic operations fail to
execute.

 Note:
Click Add To List to add the e-mail
address in the list of recipients who must
receive the e-mail notification of the
periodic operation status.

E-mail addresses Provides the list of e-mail addresses to which
the WebLM application sends the e-mail
notifications.

Add To List Adds the e-mail address that you enter in the
E-mail address field to the list of recipients
who must receive the e-mail notification of
the periodic operation status.

Remove Selected Removes the selected e-mail address from
the E-mail addresses field.

Default Periodic License Allocation Schedule

Name Description

Day The day of the week on which the master
WebLM server must send the ALF
(Allocation license file) again to the local
WebLM server.

Time The time of the day specified in the Day field
when master WebLM must send the ALF
again to the local WebLM server.

Default Periodic Usage Query Schedule

Name Description

Day The day of the week on which the master
WebLM server must query local WebLM
servers for usage reports.

Time The time of the day you specify in the Day
field when the master WebLM server must
query local WebLM servers for usage
reports.

Getting started with WebLM
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Button Description

Submit Saves the enterprise configuration.

Reset Resets the values in the fields to the values
you previously saved.

Related topics:
Configuring enterprise licensing on page 14

Managing local WebLM

Adding a local WebLM server

Before you begin

• Log on to WebLM Home.
• Install the enterprise license file.
• Identify the WebLM servers that you want to add as the local WebLM server.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Local WebLM Configuration > Add local WebLM.

3. On the Local WebLM Configuration: Add local WebLM page, enter the appropriate
information.
To successfully set up and configure the local WebLM server, enter valid information
in the mandatory fields that are marked with a red asterisk (*).
For detailed descriptions of the fields, see Add local WebLM field descriptions on
page 24.

4. In the Local WebLM Configuration section, enter the name, description, IP
address, and port of the local WebLM server. Select a protocol for the master
WebLM server to communicate with the local WebLM server.

5. In the Periodic license allocation schedule section, select the day and time for
periodic license allocations.

6. In the Periodic usage query schedule section, select the day and time of the query
for periodic usage.

7. Click Configure and validate.

Licensed products
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The system validates the information. If the information is valid, the system displays
the host ID of the computer where the server is installed in the MAC ID field.

Related topics:
Add local WebLM field descriptions on page 24

Deletion of the local WebLM server

Use the Delete Local WebLM option to delete the instance of a local WebLM server from the
master WebLM server. When you delete a local WebLM server using the Delete Local WebLM
option, the system does not remove the server physically. The master WebLM server sends a
delete request to the local WebLM server. On receiving a delete request, the local WebLM
server deletes the ALF of the product that is installed on the local WebLM server. The system
deletes the instance of the local WebLM server from the master WebLM server, irrespective
of the success or failure of the ALF deletion process on the local WebLM server.

If the master WebLM server is unable to send the delete request to the local WebLM server,
the system deletes the instance of the local WebLM server from the master WebLM server.
The ALF installed on the local WebLM server automatically expires after 30 days.

Related topics:
Delete local WebLM field descriptions on page 25

Removing a local WebLM server

Before you begin

• Log on to WebLM Home.
• Install the enterprise license file.
• Add at least one local WebLM server.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Local WebLM Configuration > Delete local WebLM.

3. On the Local WebLM Configuration: Delete local WebLM page, select the local
WebLM server that you want to delete.

4. Click Delete.

Getting started with WebLM
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 Note:
The system displays a warning message before removing the local WebLM
server from the master WebLM server.

5. Click OK.

Related topics:
Delete local WebLM field descriptions on page 25

Modifying a local WebLM server configuration

Before you begin

• Log on to WebLM Home.
• Install the enterprise license file.
• Add at least one local WebLM server.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Local WebLM Configuration > Modify local WebLM.

3. On the Local WebLM Configuration: Modify local WebLM page, select the local
WebLM server that you want to configure.

4. Click Modify.
The system displays another Local WebLM Configuration: Modify local WebLM
page with a different set of WebLM configuration fields.

5. Modify the information in the following fields:

• In the Local WebLM configuration section, Name, Description, Protocol,
and Port

• In the Periodic License Allocation schedule section, Day and Time

• In the Periodic Usage Query schedule section, Day and Time

6. Click Modify.
The system saves your changes.

Related topics:
Modify local WebLM field descriptions on page 26
Modify local WebLM field descriptions on page 26

Licensed products
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Add local WebLM field descriptions

Use this page to add a local WebLM server.

Local WebLM configuration

Name Description

Name Specifies the name of the server.

Description Provides a brief description of the server.

IP Address Specifies a unique IP address of the server.
If you enter an IP address of a server that is
already configured for a local WebLM server,
the system displays the message: IP
Address is being duplicated.

Protocol Specifies the protocol scheme over which
the master WebLM server communicates
with the local WebLM server.

Port Specifies the port number on which the
master WebLM server communicates to the
local WebLM server in the specified protocol
scheme.

MAC ID Specifies the host ID of the computer on
which you installed the server. You cannot
edit the MAC ID field.

Periodic License Allocation schedule

Name Description

Day Specifies the day of the week on which the
master WebLM server must send the ALFs
again to the local WebLM server.
By default, the system displays the settings
specified in the Enterprise Configuration. If
you change the default settings, the new
settings override the settings of the
Enterprise Configuration. However, the
change in the schedule is only applicable to
this local WebLM server.

Time Specifies the time of the day specified in the
Day field when the master WebLM server
must send the ALFs again to the local
WebLM server. By default, the system
displays the settings you specified in the
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Name Description

Enterprise Configuration. If you change the
default settings, the new settings override
the settings of the Enterprise Configuration.
However, the change in the schedule is only
applicable to this local WebLM server.

Periodic Usage Query schedule

Name Description

Day Specifies the day of the week on which the
master WebLM server must query local
WebLM servers for usage reports. By
default, the system displays the settings you
specified in the Enterprise Configuration. If
you change the default settings, the new
settings override the settings of the
Enterprise Configuration. However, the
change in the schedule is only applicable to
this local WebLM server.

Time Specifies the time of the day specified in the
Day field when the master WebLM server
must query local WebLM servers for usage
reports.
By default, the system displays the settings
you specified in the Enterprise Configuration.
If you change the default settings, the new
settings override the settings of the
Enterprise Configuration. However, the
change in the schedule is only applicable to
this local WebLM server.

Button Description

Configure and validate Configures the local WebLM server and
validates the creation of the local WebLM
server.

Back Navigates back to View local WebLMs.

Delete local WebLM field descriptions

Use this page to delete a local WebLM server.
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Name Description

Local WebLM name Specifies the name of the local WebLM
server.

IP address Specifies the IP Address of the local WebLM
server.

check box Allows you to select the local WebLM servers
that you want to delete.

Button Description

Delete Removes the local WebLM server you
selected.

Reset Clears the selection of the local WebLM
servers.

Modify local WebLM field descriptions

Use this page to select the local WebLM server whose information you want to modify.

Name Description

Local WebLM name The name of the local WebLM server.

IP address The IP address of the server.

Select Use to select the local WebLM server you
want to modify.

Button Description

Modify Saves the local WebLM configuration
changes.

 Note:
The system opens another Modify Local
WebLM page with the fields you must
modify. For field descriptions, see Modify
local WebLM field descriptions on
page 26.

Reset Clears the selection of the local WebLM
servers.

Modify local WebLM field descriptions

Use this page to modify the information of a local WebLM server.

Getting started with WebLM

26     Administering Avaya WebLM (stand-alone) February 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering Avaya WebLM (stand-alone)


Local WebLM configuration

Name Description

Name Specifies the name of the server.

Description Displays a brief description of the server.

IP Address Specifies the IP address of the server.

 Note:
You cannot modify the information in the
IP address field.

Protocol Specifies the protocol scheme over which
the master WebLM server listens to the local
WebLM server.

Port Specifies the port number on which the
master WebLM server listens to the local
WebLM server in the specified protocol
scheme.

MAC ID Specifies the host ID of the computer where
you installed the server.

 Note:
You cannot modify the information in the
MAC ID field.

Periodic License Allocation schedule

Name Description

Day Specifies the day of the week on which the
master WebLM server must send the ALFs
again to the local WebLM server.

Time Specifies the time of the day you entered in
the Day field when the master WebLM server
must send the ALFs again to the local
WebLM server.

Periodic Usage Query schedule

Name Description

Day Specifies the day of the week on which the
master WebLM server must query the local
WebLM servers for usage reports.

Time Specifies the time of the day you entered in
the Day field when the master WebLM server
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Name Description

must query the local WebLM servers for
usage reports.

Button Description

Modify Navigates to the Modify Local WebLM page
for the local WebLM server you select.

Back Discards the configuration changes and
takes you back to the Modify local WebLM
page.

Usages

Viewing usage summary

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Usages.
The system displays the Usage Summary page.

Related topics:
Usage Summary field descriptions on page 30

Viewing usage by WebLM

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Usages > Usage by WebLM.
The system displays the Usages: Usage by WebLM page.

Getting started with WebLM

28     Administering Avaya WebLM (stand-alone) February 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering Avaya WebLM (stand-alone)


3. In the Select WebLM field, select the master or local WebLM server.

4. Click Query System.

Related topics:
Usage by WebLM field descriptions on page 31

Viewing enterprise usage of a license feature

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Usages > Enterprise Usage.
The system displays the Usages: Enterprise Usage page.

3. In the Select Feature (License Keyword) field, select the licensed feature.
The page displays the usage of the licensed feature for the master WebLM server
and the local WebLM servers.

Related topics:
Enterprise Usage field descriptions on page 32

Querying usage of feature licenses for master and local WebLM servers

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Usages > Query Usage.
The system displays the Usages: Query Usage page.

3. To view the usage details by feature licenses of a server, select the master or local
WebLM server.

4. Click Query Usage.
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If you select all WebLM severs or click Check All and click Query usage, the
system displays the progress of the query request.

Result
If you select one local WebLM server, the Usages: Usage by WebLM page displays the details
of the local WebLM server you selected.

Related topics:
Query Usage field descriptions on page 33

Usage Summary field descriptions

Use this page to view the usage summary for a master WebLM server, a local WebLM server,
or all the WebLM servers of the product.

Name Description

WebLM Name Displays the names of the master WebLM
server and local WebLM servers of the
product.

IP address Specifies the IP address of the master
WebLM server and local WebLM servers of
the product.

Time of Query Specifies the date and time when the system
executed the last usage query for the
WebLM server. If the status of the last usage
query is Failed, this column also displays
the date and time of the usage query that was
last successful.

Status Specifies the success or failure status of the
last usage query that the system executed
for each WebLM server. The Status column
of a WebLM server remains blank if the
server is not queried even once for feature
license usage. The usage query can be a
periodic usage query or a nonperiodic usage
query.

Related topics:
Viewing usage summary on page 28
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Usage by WebLM field descriptions

Use this page to query the feature license usage by the master and local WebLM servers.

Name Description

Select WebLM The master and local WebLM servers for
which you can view the usage.

Feature (License Keyword) The name and keyword of the counted
features of the product.

Currently Allocated The number of feature licenses for each
feature that the system currently allocates to
the selected WebLM server. For the master
WebLM server of the product, this column
lists the floating licenses available with the
server.

Usage: qty/% The number of feature licenses for each
feature that the licensed applications
currently use from the allocated feature
licenses. The column also displays the
percentage of usage.
For example, if 50 feature licenses are
allocated and applications use five feature
licenses, this column displays 5/10%.

Peak Usage (last 7 days): qty/% The highest number of feature licenses for
each feature that the applications use in the
past seven days. The column also displays
the percentage of peak usage.
For example, if the peak usage in the past
seven days was 25 and 50 feature licenses
were available during the peak usage
calculation, the column displays 25/50%.

Peak Usage (last 30 days): qty/% The highest number of feature licenses for
each feature that the applications use in the
past 30 days. The column also displays the
percentage of peak usage.
For example, if the peak usage in the past 30
days was 50 and 50 feature licenses were
available during the peak usage calculation,
the column displays 50/100%.

Time of Query The date and time when the system
executed the usage query for the WebLM
server you select.

Status The success or failure of the last usage query
process executed for each WebLM server.
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Name Description

The Status column remains blank if the
server is queried even once for feature
license usage. The usage query can be a
periodic usage query or a nonperiodic usage
query.

Button Description

Query System Queries the selected WebLM server for the
feature license usage.

Related topics:
Viewing usage by WebLM on page 28

Enterprise Usage field descriptions

Use this page to view the feature license usage of all WebLM servers for the selected
feature.

Name Description

Select Feature (License Keyword) Specifies the license features for which you
can view the license usage.

License capacity Specifies the total number of feature licenses
the organization purchases for each
feature.

Available Lists the number of licenses currently
available with the master WebLM server.

WebLM Name Specifies the names of the WebLM servers
of the product.

Currently Allocated Specifies the number of feature licenses that
the system currently allocates to the WebLM
servers for the selected feature.

Usage qty/% Specifies the number of feature licenses that
the licensed applications currently use, from
the allocated feature licenses for the
selected feature. The column also displays
the percentage of usage. For example, if 50
is the allocated feature licenses and 5 feature
licenses have been used by the applications,
this column displays 5/10%.

Peak Usage (last 7 days): qty/% Specifies the highest number of feature
licenses that applications use in the past
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Name Description

seven days for the selected feature. The
column also displays the percentage of peak
usage. For example, if the peak usage in the
past seven days is 25 and the feature
licenses those were available during the
peak usage calculation is 50, the column
displays 25/50%.

Peak Usage (last 30 days): qty/% Specifies the highest number of feature
licenses that applications use in the past 30
days for the selected feature. The column
also displays the percentage of peak usage.
For example, if the peak usage in the past 30
days is 50 and the feature licenses those
were available during the peak usage
calculation is 50, the column displays
50/100%.

Time of Query Specifies the date and time when the system
executes the usage query for the selected
feature.

Status Specifies the status of the last usage query
process that the system executes for each
WebLM server. The status can be Success
or Failure.

Related topics:
Viewing enterprise usage of a license feature on page 29

Query Usage field descriptions

Use this page to query the master WebLM server, a local WebLM server, or all the WebLM
servers of the product for the feature license usage report.

Name Description

WebLM Name Specifies the names of the master and the
local WebLM servers of the product as links.
To view the feature license usage of a server,
select the name of the required server in the
WebLM Name column.

 Note:
If the specified WebLM server is not
queried even once for feature license
usage, the table on the Usage by WebLM
page remains blank.
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Name Description

IP address Specifies the IP address of the master
WebLM server and the local WebLM servers
of the product.

Time of Query Specifies the date and time when the system
executes the last usage query for the WebLM
server. If the status of the last usage query is
Failed, the Time of Query column
displays the date and time of the usage query
that was last successful.

 Note:
If the server does not receive a query
request even once for feature license
usage, the Time of Query column of a
WebLM server remains blank.

Status Specifies the success or failure of the last
usage query that the system executes for
each WebLM server. If the server does not
receive a query request even once for
feature license usage, the Status column of
a WebLM server remains blank. The usage
query can be a periodic usage query or a
nonperiodic usage query.

Select Check box Use to select the WebLM server for which
you want to determine the usage query.

Button Description

Check All Selects all the WebLM servers.

Clear All Clears the selections for all the WebLM
servers.

Query Usage Queries the WebLM servers of the product
you select for their feature license usage
report.

Related topics:
Querying usage of feature licenses for master and local WebLM servers on page 29
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Allocations

Viewing allocations by features

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Allocations > View by feature.
The system displays the Allocations: View by Feature page.

Related topics:
Allocations by Features field descriptions on page 36

Viewing allocations by the local WebLM server

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Allocations > View by local WebLM.
The system displays the Allocations: View by Local WebLM page.

3. In the Select Local WebLM field, select the local WebLM server.

Result
The page displays the allocation details for the local WebLM server you select.

Related topics:
Allocations by Local WebLM field descriptions on page 37
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Changing allocations of licensed features for a local WebLM server

Use this functionality to change the license allocations of a feature that resides on a local
WebLM server for the product.

Procedure

1. Log in to the master WebLM server.

2. In the left navigation pane, click Licensed products and select the product
name.

3. Click Allocations > Change allocations.
The system displays the Allocations: Change Allocations page.

4. In the New Allocation column, enter the number of licenses you want to allocate
for the feature that resides on a local WebLM server.

5. Click Submit Allocations.

Related topics:
Change Allocations field descriptions on page 38

Allocations by Features field descriptions

Use this page to view the feature license allocation information for each counted type feature
of the product.

Name Description

Feature (License Keyword) Specifies the name and license keyword of
the counted features of the product.

Local WebLM Name Specifies the name of the local WebLM
servers of the product. By default, this
column is blank. The system displays the
names of the local WebLM servers only
when you select the arrow head in the
Feature (License Keyword) column. If a
local WebLM server does not exist for the
product, the Local WebLM Name column
remains blank for all the licensed features.

IP address Specifies the IP addresses of the local
WebLM servers of the product. By default,
this column is blank. The system displays the
IP address of the local WebLM servers only
when you select the arrow-head in the
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Name Description

Feature (License Keyword) column. If a
local WebLM server does not exist for the
product, the IP address column remains
blank for all the licensed features.

License Capacity Specifies the total number of feature licenses
purchased by the organization for the
respective feature.

Currently Allocated Specifies the total number of feature licenses
of the respective feature that the system
allocated to the local WebLM servers of the
product. If a licensed feature is not allocated
to any local WebLM server, the system
displays zero in the Currently Allocated
column for the licensed feature.

Available Lists the number of floating licenses of the
respective feature that is currently available
with the master WebLM server.

 Note:
To view the information about the number of feature licenses of a feature that the system
allocates to each local WebLM server, click the arrow-head beside the name of the required
feature. The system displays new rows below the feature row with the feature license
allocation information for each local WebLM server to which the feature is allocated.

Allocations by Local WebLM field descriptions

Use this page to view the feature license allocation information by local WebLM.

Name Description

Select Local WebLM Specifies the local WebLM servers for which
you can view the feature license allocation
information.

Last Allocation Specifies the date and time when feature
licenses were last allocated to the local
WebLM server you select.

Status Specifies the success or failure status of the
last license allocation process that the
system executes for the local WebLM server
you select. The allocation process can be a
periodic allocation process or a nonperiodic
allocation process. If the status of the last
license allocation process is Failed, and if
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Name Description

the status of a previous license allocation
process for the server is Success, the
system displays the date and time of the last
license allocation process that was
successful in the Last Allocation field.

Feature (License Keyword) Specifies the name and license keyword of
the counted features that the system
allocates to the local WebLM server you
select.

License Capacity Specifies the total number of feature licenses
the organization purchases for each
feature.

Currently Allocated Specifies the total number of feature licenses
of each feature that the system allocates to
the local WebLM server you select.

Available Lists the number of licenses currently
available on the master WebLM server for
allocation to local WebLM servers.

Change Allocations field descriptions

Use this page to change current feature license allocation information for each local WebLM
server of a product.

Name Description

Feature (License Keyword) Specifies the name and license keyword of
the counted features that the system
allocates to the local WebLM server you
select.

Local WebLM Name Specifies the name of the local WebLM
server.

IP address Specifies the IP addresses of the local
WebLM servers of the product.

License Capacity Specifies the total number of feature licenses
that the organization purchases for each
feature.

Currently Allocated Specifies the total number of feature licenses
of each feature that the system allocates to
the local WebLM server you select.
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Name Description

Currently Used Specifies the total number of feature licenses
of each feature that the product uses.

Available Specifies the number of floating licenses of
each feature that is currently available with
the local WebLM server.

New Allocation Specifies the number of new licenses that the
system allocates to a local WebLM server.

Button Description

Submit Allocations Allocates the number of feature licenses that
you specify in the New Allocation field to the
corresponding local WebLM servers.

Reset Resets the values that you specify in the New
Allocation field to the previously saved
value.

Periodic status of the WebLM server

Viewing the periodic status of the master and local WebLM servers

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Licensed products and select the product
name.

2. Click Periodic status.
The system displays the Periodic Status page.

Related topics:
Periodic Status field descriptions on page 39

Periodic Status field descriptions

Use the Periodic Status option to view the status of periodic operations such as the periodic
allocation of the feature licenses to the local WebLM server and querying of the local WebLM
server for usage report.
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Periodic Allocation

Name Description

Local WebLM Name Specifies the name of the local WebLM
server of a product.

IP Address Specifies the IP addresses of all the local
WebLM servers of the product.

Last Allocation Displays the date and time when the system
executed the last periodic license allocation
process for each local WebLM server. If the
status of the last periodic license allocation
process is Failed, the Last Allocation
column displays the date and time of the
periodic license allocation process that was
last successful.

Status Displays the success or failure status of the
last periodic license allocation process that
the system executed for each local WebLM
server.

Periodic Usage

Name Description

WebLM Name Displays the name of the master WebLM
server and local WebLM servers of a
product.

IP Address Displays the IP addresses of the master and
local WebLM servers of a product.

Last Usage Query Displays the date and time when the system
executed the last periodic usage query for
each WebLM server. If the status of the last
periodic usage query is Failed, the Last
Usage Query column also displays the date
and time of the periodic usage query that was
last successful.

Status Displays the success or failure status of the
last periodic usage query that the system
executed for each WebLM server. If the
server is not queried even once for feature
license usage, the Status column of a
WebLM server remains blank.
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Uninstalling the license file

Removing a license file
Use this functionality to remove the license file that you install on the WebLM server.

Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Uninstall license.

2. On the Uninstall License page, select the license file that you want to delete.

3. To remove the license file from the WebLM server, click Uninstall.

Related topics:
Uninstall license field descriptions on page 41

Uninstall license field descriptions
Use this page to remove a license file from the WebLM server for a licensed product.

Field Description

Installed license file Specifies the name of the license files
currently installed on the WebLM server.

Products Specifies the products for which licenses are
installed on the WebLM server.

SID Specifies the System ID of the license file.

Select Check box Use to select the license files that you want
to remove from the WebLM server.

Button Description

Uninstall Removes the selected license files from the
WebLM server.
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Server properties

Viewing the server properties
Before you begin
Log on to WebLM Home.

Procedure

In the left navigation pane, click Server properties.
The Server Properties page displays the host ID. The host ID is the MAC address of
the computer on which you installed WebLM.

 Note:
The host ID specified in PLDS is embedded in the license file. You can install the
license file only if the host ID of the target computer matches the host ID in the license
file. Therefore, when you request for a license file, specify the correct host ID of the
computer where the WebLM server is installed.

Related topics:
Server Properties field descriptions on page 43

Setting the usage history count
Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Server properties.

2. In the Usage history count section, set the Count from the list.

3. Click Submit.
The Count specifies the number of usage query results that the server maintains.
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 Note:
You can view the Usage history count section only if you install at least one
enterprise license file in the WebLM server.

Server Properties field descriptions
Use this page to view the MAC address of the server.

Server Host ID

Field Description

Primary Host ID Displays the MAC address of the server.
You can assign more than one MAC address
to the server. The first MAC address is the
primary MAC address and subsequent MAC
addresses are designated as secondary
MAC address, tertiary secondary MAC
address. Use the primary MAC address in
the license file.

 Note:
In a Solaris server, where the MAC
address is not available, for example, in a
zoned environment, WebLM retrieves the
8–digit hexadecimal host ID of the server
and adds leading zeros to make the ID a
12–digit address.

Usage history count

Field/Button Description

Count Specifies the number of usage query results
that the server maintains.

Submit Commits the changes you made to the
Server Properties page.

Cancel Discards the changes you made to the
Server Properties page.
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Managing users

Adding a new user
Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Manage users.

2. Click New.

3. On the New User page, enter the User Name, Password, and Confirm Password
fields.

4. Click Add.

Related topics:
Manage users field descriptions on page 45

Deleting the user
Before you begin
Log on to WebLM Home.

Procedure

1. On the left navigation pane, click Manage users.

2. On the Manage Users page, select the users you want to delete.

3. Click Delete.

4. To delete the users, on the confirmation dialog box, click OK.

Related topics:
Manage users field descriptions on page 45
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Editing user password
Before you begin
Log on to WebLM Home.

Procedure

1. In the left navigation pane, click Manage users.

2. On the Manage Users page, select the user you want to modify.

3. Click Edit.

4. Edit the New Password field.

5. In the Confirm Password field, re-enter the new password.

6. Click Change.

 Note:
You cannot edit the user name from the Manage Users page.

Related topics:
Manage users field descriptions on page 45

Manage users field descriptions

Name Description

User Name The user name of the admin or non-admin
WebLM user.

Reset Password Specifies whether the log-in password has
changed at least once after the creation of
the user ID.
The Reset Password column displays true
for user IDs whose password is not changed
even once after the creation of the ID. The
column displays false for user IDs whose
log-in password is changed at least once.

Button Description

New Adds the user to the WebLM database.

Edit Modifies the user password.
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Button Description

Delete Deletes the user from the WebLM
database.

Logging out of the WebLM server
Before you begin
Log on to WebLM Home.

Procedure

At the top-right corner of the Web page, click Log off.
The system displays the log-in page. To use WebLM, you must log in to the WebLM
server.
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Chapter 4: Troubleshooting WebLM (stand-
alone)

Overview
This section provides detailed information to help you resolve issues with the standalone
version of WebLM. The section is intended for people who install, configure, and maintain
WebLM for both standard and enterprise license configurations.

WebLM launching errors

Launching of WebLM fails

Symptom The system fails to launch WebLM with the following errors:
- A 404 error when you gain access to WebLM from the browser.
- A Connection refused error when you communicate with WebLM server

using the client API.

Cause of the
issue

- If the Tomcat service fails to run.
- If you use an incorrect URL to gain access to WebLM.
- If you have network connectivity issues while gaining access to WebLM from

a remote computer.
- If the configuration of HTTPS in the server.xml file of Tomcat is

incorrect.
- If several applications run on the server that hosts Tomcat, and the server

caters to a large number of simultaneous requests.

Related topics:
Proposed solution 1 on page 48
Proposed solution 2 on page 48
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Proposed solution 3 on page 49
Proposed solution 4 on page 49
Proposed solution 5 on page 49

Proposed solution 1
Before you begin
Obtain a valid license file for the WebLM server.

Procedure

If Tomcat is started as a service, to verify that the service is running, perform one of
the following:

• For Windows, to verify the status of the Tomcat service, click Control Panel >
Administrative Tools > Services.

• For Linux, at the command prompt, enter service tomcat status.

From the list of services, the system must display the status of Apache Tomcat
as Started.

Proposed solution 2
Procedure

To gain access to the WebLM server, enter the URL in one of the following formats:

• From the browser, enter one of the following:

- http://<HOST_NAME/IP_ADDRESS>:<HTTP_PORT>/WebLM/
index.jsp

- https://<HOST_NAME/IP_ADDRESS>:<HTTPS_PORT>/WebLM/
index.jsp

• From the client API, enter one of the following:

- http://<HOST_NAME/IP_ADDRESS>:<HTTP_PORT>/WebLM/
LicenseServer

- https://<HOST_NAME/IP_ADDRESS>:<HTTPS_PORT>/WebLM/
LicenseServer
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Proposed solution 3
About this task
To gain access to the WebLM server over the network:

Procedure

1. Ensure that the connectivity to the network exists.

2. Verify that the firewall does not block any ports that Tomcat listens to.

Proposed solution 4
Procedure

To use HTTPS protocol, you must enable HTTPS in one of the following files:

• On a Linux system. $CATALINA_HOME/conf/server.xml
• On a Windows system. %CATALINA_HOME%\conf\server.xml

Proposed solution 5
A number of applications run on the WebLM server that hosts Tomcat, and the server caters
to several requests simultaneously.

Procedure

1. Ensure that the Tomcat configuration supports the load expected on the system.

2. If required, modify the Tomcat configuration to support more requests
simultaneously. For details of changing the Tomcat configuration, see Tomcat
configuration guide.
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License file installation errors

Installation of license file on the WebLM server fails

Scenario 01
The installation of a license file on the WebLM server fails for several reasons. The following
sections provide some troubleshooting scenarios and proposed solutions:

Symptom1 The system displays the following error:
Error installing license. An error occurred while
performing license installation checks. Please ensure
that all the required steps were performed before
deploying WebLM server.

Cause of the
issue

- If the following sequence of events occurs:

i. You run an instance of the Tomcat/WebLM server as root.

ii. You successfully install a license file for a product, for example product
A.

iii. The instance of the Tomcat/WebLM server exits ungracefully. As a result,
the file cleanup process fails.

iv. Redeploy or restart the Tomcat/WebLM server as another user, for
example tomcat5. As a result, an existing license file fails to load on
startup.

v. If you attempt to install a new license file for the same product, product
A.

- If multiple instances of the WebLM server run on the same server, and you
install a license file for a product on an instance of the WebLM server when
a license is already hosted on another instance of the WebLM server.

- If the user ID you use to start the Tomcat service does not have the write
permission for the following directory:

• On a Linux system, /var/tmp
• On a Windows system, C:\temp
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Related topics:
Proposed solution on page 51

Proposed solution
Before you begin
Obtain a valid license file for the WebLM server.

Procedure

1. Start only one instance of the WebLM server on the system at a time.

2. Ensure that the user ID you use to start the Tomcat service has write permissions
for the following directory:

• On a Linux system, /var/tmp
• On a Windows system, C:\temp

3. If the system still displays the error, perform the following:

a. Verify that a lock file exists and has the .##machineNameproductName.l
file naming convention.

b. To view the lock file, perform one of the following:

• On a Windows system, the lock file exists in the C:\temp directory and
the file is hidden. Enable the view hidden files option using the following
steps:

1. Browse to the C:\temp directory.

2. Click Tools > Folder Options.

3. Click the View tab.

4. In the Advanced settings section, select Files and Folders >
Hidden files and folders > Show hidden files and folders.

5. Click Apply and then click OK.

The system displays the lock file in the list.

• On a Linux system, to view the lock file, enter ls –al /var/tmp.

c. If the lock file exists, stop Tomcat gracefully and delete the lock file.

d. If the license file exists, remove the file from the $CATALINA_HOME/webapps/
WebLM/licenses directory on a Linux system or %CATALINA_HOME%
\webapps\WebLM\licenses on a Windows system. The license file must
have a .xml extension.
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e. Start Tomcat.

4. To install the license file, on the WebLM Home page, click Install license and
proceed with the installation steps.
For instructions on installing a license file, seeInstalling a license file on page 11.

The system installs the license file on the WebLM server.

Scenario 02

Symptom 2 The system displays the following error:
Error installing license. License file is invalid or not
created for this server. License file was not
installed.

Cause of the
issue

The error occurs due to one of the following reasons:
- If the MAC address in the license file fails to match the MAC address of

the system hosting the WebLM server.
- If you modify the license file.
- If the license file name contains special characters that the system fails to

support.

Related topics:
Proposed solution on page 52

Proposed solution
Procedure

Depending on the cause of the error, perform one of the following:

• Perform the following:

i. Log on to WebLM Home.

ii. On the left navigation pane, click Server properties and verify that the
MAC address in the license file matches the MAC address displayed
on the Server Properties page.

The Server properties page displays the MAC addresses for all
available NICs on the system on which you installed WebLM. The MAC
address in the license file must match the MAC address of the system
on which the WebLM server is running.
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• Verify that the license file is not edited. If the license file is edited, revert the
changes or install the original license file that you receive from PLDS.

• Verify that the name of the license file does not contain the following characters:

- On a Windows system, % ^ { } # `

- On a Linux system, % ^ { } # ` [ ]

If the name of the license file uploaded on the WebLM server contains any of the
characters that the system does not support, remove the characters from the file
name and install the license file.

 Important:
The system supports the following sets of characters in the name of the license
file for both Windows and Linux: ~ ; . , ! ‘ = + @ ( ) & $ - and whitespace.

Scenario 03

Symptom 3 The system displays the following error:
Error installing license. License installation failed. The
product already exists with a SID
<SID_IN_EXISTING_LICENSE_FILE>, which is different than
the one present, <SID_IN_NEW_LICENSE_FILE>, in new license
file.

Cause of
the issue

If a license file for a product is already installed on the WebLM server and you
attempt to install another license file for the same product with a different System
Identification number (SID) on the WebLM server.
You encounter this issue when you have a license file generated by Remote
Feature Activation (RFA) installed on a WebLM server for a product. The license
file that RFA generates has an RFA generated SID value. You then receive an
updated license file for the same product from PLDS. The new license file for
the same product contains a different SID value. The system displays the error
message when you attempt to install the new file on the existing file.

Related topics:
Proposed solution on page 53

Proposed solution
When the existing license file and the new license file for a given product have different SID
values, you cannot install the new license file when a license file exists on the WebLM server.
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You must uninstall the existing license file from the WebLM server and then install a new license
file on the server.

Before you begin
Log on to WebLM Home.

Procedure

1. For a standard or an enterprise license file, where enterprise or local WebLM
configuration is not set:

a. To uninstall the existing license file, click Uninstall license, and follow the
instructions provided in Removing a license file on page 41.

 Note:
The system removes the existing license file for the product. You lose all the
existing usage data for the product.

b. To install a new license file, click Install license, and follow the instructions
provided in Installing a license file on page 11.
The system installs the new license file for the product.

2. For an enterprise license file, where you added local WebLM servers:

a. In the left navigation pane, click Licensed products and select the product
name.

b. Click Local WebLM Configuration > Delete local WebLM.

c. Click Delete.

 Note:
The system removes the license file allocated to the local WebLM servers
that you added to this enterprise setup. As a result, licensed applications
which are in the process of acquiring licenses from the local WebLM servers
fail to acquire any new licenses or renew the existing licenses.

d. To uninstall the existing license file, click Uninstall license, and follow the
instructions provided in Removing a license file on page 41.

 Note:
The system removes the existing license file for the product. You lose all the
existing usage data for the product.

e. To install a new license file, click Install license, and follow the instructions
provided in Installing a license file on page 11.
The system installs the new license file for the product. You must configure the
enterprise again, add local WebLM servers, and allocate the license for the local
WebLM servers you added.
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Scenario 04

Symptom 4 The system displays the following error:
Unsupported content type. License contents must
be ”text/xml”.

Cause of the
issue

The error occurs due to the following reasons:
- If you click Install before you select a license file.
- If you fail to select a license file that has a .xml extension.

- If the license file you use to install contains invalid XML content.
- If the browser settings are incorrect.
- If the registry settings are incorrect.

Related topics:
Proposed solution on page 55

Proposed solution
The installation of the license file may fail if you install the license file on a WebLM server from
a particular browser or a system. However, you can successfully install the same file on the
WebLM server by gaining access to the same WebLM server from another browser or system.
The failure may have been a result of improper browser or registry settings.

Before you begin

• Obtain a valid license file.
• Log on to WebLM Home.

Procedure

1. To install a new license file, click Install license, and follow the instructions provided
in Installing a license file on page 11.

2. Verify that the browser setting are appropriate. You can use the default settings to
upload the license file.

3. To verify that the registry settings on Windows are appropriate, perform the following
procedure:

a. At the command prompt, enter regedit.
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b. On the Registry Editor window, ensure that the Extension Key in the
HKEY_CLASSES_ROOT/MIME/Database/Content Type/application/
xml directory is .xml.

4. Verify if you can install the license file from a different browser or from a different
system.

WebLM password errors

WebLM password resetting

Symptom When you provide your credentials to log in to WebLM, the system
displays a log-in failure error message.

Cause of the issue You forget or lose the password for the WebLM login.

Related topics:
Proposed solution 1 on page 56
Proposed solution 2 on page 57

Proposed solution 1
If a non-admin user fails to log in to the WebLM server using the existing credentials, you must
reset the password.

Procedure

1. Log in to the WebLM as admin.

2. On the left navigation pane, click Manage users.

3. Select the user whose password you want to reset.

4. Enter a new password for the user.

Next steps
When the user logs in to WebLM, the system prompts for a password change. The user must
change the password on the first login.
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Proposed solution 2
WebLM stores the user data in an XML file called Users.xml. The system packages the XML
file in a WebLM.war file in the admin directory.

Before you begin
Log on to WebLM Home.

About this task
To reset the admin WebLM password, replace the existing user data file with the default WebLM
user data file.

 Note:
When you replace the existing file with the default file, you lose all existing user data. You
only have the default user data for the admin user. You must add the data of the previously
existing users again from the WebLM Web interface.

Procedure

1. Stop Tomcat.
When Tomcat stops, applications deployed on the server that host Tomcat stop
responding.

2. Replace the existing Users.xml file with the default Users.xml file that you
extracted from the WebLM.war file located in the following directories:

• On a Linux system, $CATALINA_HOME/webapps/WebLM/admin
• On a Windows system, %CATALINA_HOME%\webapps\WebLM\admin

3. Start Tomcat.

4. On the log-in page, provide the following credentials: User Name = admin and
Password = weblmadmin.

5. At the system prompt, change the password and log in to the WebLM again using
the new password.

6. To add a new user to WebLM, on the WebLM Web interface, click Manage users
and follow the instructions provided in Adding a new user on page 44.
The system prompts the new user to change the password on the first login.
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Appendix A: Recommendations to select a
WebLM configuration model

Depending on the need and infrastructure of an organization, the organization can configure WebLM in
one of the following licensing models:

• WebLM standard model

• WebLM enterprise model

WebLM standard licensing model
WebLM standard licensing is an old model and offers an easy and simple solution with limited
functionality. Use the standard configuration model if the Avaya product is a stand-alone
product installed on a computer.

To configure a standard model, you must install a standard license file (SLF) and configure the
WebLM server for the licensed applications to acquire the feature licenses.

The standard model provides the following information regarding the feature license usage:

• Usage at a particular time

• Peak usage for the last 7 days

• Peak usage for the last 30 days

The standard licensing model does not support many new features of WebLM.

The standard licensing model has the following limitations:

• The model does not offer any redundancy because the model uses only one WebLM
server as the source of feature licenses. If the WebLM server fails or becomes unavailable
due to any reason, the licensed applications do not have other means to acquire feature
licenses or renew the acquired feature licenses.

• The model does not suit an organization that has licensed applications spread globally.
All the licensed applications must contact a single WebLM server that may lead to network
issues.

• In this model, the WebLM server does not maintain the usage history.

Related topics:
WebLM configuration model checklist on page 61

Administering Avaya WebLM (stand-alone) February 2012     59



WebLM enterprise licensing model
WebLM enterprise licensing is a more recent model and offers more features to the end user
as compared to the WebLM standard licensing model. The WebLM enterprise licensing model
provides the following features:

• Provides the flexibility to move feature licenses across various WebLM servers, master
and local. Therefore, even if a WebLM server is unavailable or is out of feature licenses,
the licensed applications can still acquire feature licenses from the other servers.

• Suits an organization that has licensed applications spread globally. With the enterprise
model, the organization can have feature licenses allocated to various local WebLM
servers, which in turn can serve licensed applications in a region. Additionally, with the
usage history, the administrator can move WebLM feature licenses from local WebLM
servers that have low usage to the local WebLM servers that have high usage.

• Periodic allocation. The licensed application can also acquire feature licenses from the
master WebLM server. The unallocated feature licenses available with the master WebLM
server are known as floating licenses. To avoid feature licenses being stagnant in a single
location and maximize feature license usage, the allocation license files to local WebLM
servers are valid only for 30 days. However, to ensure that local WebLM servers never
run out of feature licenses, the master WebLM server copies the ALFs to the local WebLM
servers after every seven days. If the periodic allocation process fails, the retry feature
ensures that the system makes decent number of attempts to execute the process. If the
periodic allocation process is not successful even after the retry attempts, the system
notifies the administrator through an e-mail.

• Periodic usage query. The periodic usage query process retrieves feature license usage
information from each local WebLM server configured on the master WebLM server or
the floating license usage information from the master WebLM server after every seven
days. Using the periodic usage query feature, administrators of the master WebLM server
can ensure that administrators periodically receive feature license usage information,
even if the administrators forget to execute a usage query.

The usage information from the WebLM servers across the organization helps administrators
to determine if the purchased feature licenses are sufficient for the organization. If the feature
licenses are insufficient, administrators can plan to purchase more feature licenses for the
organization.

Related topics:
WebLM configuration model checklist on page 61
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WebLM configuration model checklist
The checklist for WebLM configuration model lists the features of WebLM with the summary
of the features each configuration model supports.

The WebLM team creates the WebLM configuration model checklist. Use the checklist to
decide the WebLM configuration model that suits the needs and infrastructure of your
organization.

Feature WebLM Standard
model

WebLM Enterprise
model

License Installation using user
interface (UI)

Yes Yes

Change Password Yes Yes

Feature Overuse Yes Yes

Manage Users (add, modify and
delete)

Yes Yes

License acquisition using client APIs -
Pull model

Yes Yes

Acquired license details Yes Yes

Update history count No Yes

Peak Usage (last 7 days) Yes Yes

Peak Usage (last 7 days) with history
(max - 5)

No Yes

Peak Usage (last 30 days) Yes Yes

Peak Usage (last 30 days) with history
(max - 5)

No Yes

Usage query Yes Yes

Usage query with history (max - 5) No Yes

LAR license type support Yes Yes

Enterprise configuration No Yes

E-mail notification - in case of failure
(periodic operations)

No Yes

Local WebLM configuration - Add No Yes

Local WebLM configuration - Delete No Yes

Local WebLM configuration - Modify No Yes
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Feature WebLM Standard
model

WebLM Enterprise
model

Perform validate connectivity test No Yes

View usage at Enterprise level No Yes

Allocations (push ALF to Local
WebLM) - Push mode

No Yes

Periodic allocation (every 7th day) No Yes

Periodic usage query (every 7th day) No Yes

Redundancy No Yes

Floating license (available for
acquisition)

No Yes

Long term vision No Yes

HTTPS support Yes Yes

Client API Support (all APIs) Yes Yes
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